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ObjectifsObjectifs

> Prise en main de l’environnement ANSYS Electronics Desktop (V16) – HFSS

> Création d’un projet from scratch

> Flot de modélisation et post-processing typique

> Utilisation des différentes solutions (driven modal/terminal modal) et excitations 
(wave port/lumped port)

> Calcul des paramètres S

> Calcul tensions/courants à l’aide de la calculatrice de champ

> Calcul du rayonnement en champ proche et champ lointain
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Cas étudiéCas étudié

> Ligne microruban 56 Ω de géométrie

> Simulation des paramètres S

Hsub = 1.6 mm

W = 2.5 mm

T = 35 µm

L = 100 mm

Lsub = 120 mm

Wsub = 100 mm

 Piste et plan de masse 
en cuivre.

 Substrat FR4 (εr = 4.4)

x
y

z

 Origine du repère placé au centre de la 
ligne, sur le plan de masse.
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Création du projet / design HFSSCréation du projet / design HFSS

> Soit on recréé un nouveau projet from scratch, en suivant la démarche présentée 
dans la partie 1…

> Soit File > Save as  Microstrip_Project3

> On reste en solution de type Terminal (si on souhaite avoir des résultats sous la 
forme de courants/tensions)
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Modification du modèleModification du modèle

> HFSS > Design properties > bouton Add ou clic droit sur le nom du projet > Design properties

> On change Lsub  120 mm

> On change aussi Hairbox  75 mm

> On supprime les 2 rectangles servant aux waveports
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Création des excitationsCréation des excitations
> Changer le drawing plane  YZ

> Dessiner deux rectangles (Draw Rectangle) aux deux extrémités de la ligne, placées 
entre la ligne et le plan de masse. 

> Pas de propriétés à attribuer, vont simplement servir à placer les lumped ports.
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Création des excitationsCréation des excitations

Excitations lumped ports à placer ici
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Création des excitationsCréation des excitations
> Sélectionnez le premier rectangle, clic droit HFSS > Excitation > 

Assign > Lumped Port

> Même chose pour le second rectangle  waveport2

> On conserve les mêmes conditions aux limites et la même 
analyse (on passe néanmoins à 15 passes min. pour assurer la 
convergence).
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Simulation paramètres SSimulation paramètres S

> Résultat de simulation :

> Résultat proche des précédents. Ecarts liés aux différences de maillage et de 
type de solution.
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Simulation paramètres ZinSimulation paramètres Zin

> Résultat de simulation :

> Résultat proche des précédents. Ecarts liés aux différences de maillage et de 
type de solution.

Zc estimée à 60 Ω
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Rayonnement de la pisteRayonnement de la piste

> On souhaite simuler le rayonnement de la piste, excitée d’un côté et terminée de 
l’autre par une résistance 50 Ω.

> On supprime l’excitation sur le port 2 pour la remplacer par une charge localisée :  
HFSS > Boundaries > Assign > Lumped RLC

> Au préalable, zoomer sur le rectangle 2, là où l’on va placer la charge afin de dessiner 
la « Current Flow Line ».

Current flow line

A sélectionner pour dessiner 
la current flow line
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Rayonnement de la pisteRayonnement de la piste

> On ajoute une analyse de rayonnement champ lointain.

> HFSS > Radiation > Insert Far Field Setup > Infinite Sphere

Visible ici
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Rayonnement de la pisteRayonnement de la piste

> On effectue un changement dans le balayage en fréquence pour calculer et conserver 
les champs électromagnétiques à toutes les fréquences (non faits en mode 
Interpolating).

> Echantillonnage fréquentiel discret  attention, c’est plus long !
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Rayonnement de la pisteRayonnement de la piste

> HFSS > Fields > Edit sources

> Informations sur la (les) sources utilisées

Tension que l’on mesurera aux bornes d’une charge adaptée connectée à 
cette source  l’amplitude du générateur = 2 V.
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Rayonnement de la pisteRayonnement de la piste

> Lancement de la simulation classique ou sélectionner Infinite Sphere dans Project 
Manager puis HFSS > Radiation > Compute Antenna Parameters

> Affichage du résumé de calcul : 
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Rayonnement de la pisteRayonnement de la piste

> Affichage d’une vue 3D du diagramme de rayonnement avec HFSS > Results > 
Create Far Field Report > 3D Polar Plot

Sélectionner Sweep1 pour afficher 
les résultats aux différentes fréq.



LAAS-CNRS
/ Laboratoire d’analyse et d’architecture des systèmes du CNRS 17

Rayonnement de la pisteRayonnement de la piste

> Affichage d’une vue 2D du diagramme 
de rayonnement avec HFSS > Results > 
Create Far Field Report > Rectangular
Plot
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Analyse courant tensionAnalyse courant tension

> Sélectionner une des faces d’extrémité de la piste (Edit > Select > Face)

> HFSS > Fields > Plot Field > J > Mag _Jsurf
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Analyse courant tensionAnalyse courant tension

> Sélectionner la face supérieure du plan de masse (Edit > Select > Face)

> HFSS > Fields > Plot Field > J > Mag _Jsurf puis Vector_Jsurf (sélectionnez 
0.1 GHz)

Pour modifier les propriétés 
du tracé graphique
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Analyse courant tensionAnalyse courant tension

> On dessine un rectangle à 1 mm de l’extrémité de la ligne opposée à l’excitation.

> On nomme ce rectangle ProbeCurrent  on va mesurer le courant en intégrant la 
densité de courant volumique traversant cette surface.
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Analyse courant tensionAnalyse courant tension

> Ouverture de la calculatrice de champ : 
HFSS > Fields > Calculator

> Liste des opérations :
 Quantity > Jvol

 Complex > CmplxMag

 Geometry > Surface > ProbeCurrent

 Normal

 ∫

 Eval

Permet d’évaluer une grandeur 
électromagnétique (ici le courant entrant 
dans la charge) pour une seule fréquence.
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Analyse courant tensionAnalyse courant tension

> Il est possible de définir une expression 
basée sur le calcul de la grandeur 
électromagnétique précédente.

> Effacer les opérations précédentes : Clear

> Reprendre les opérations précédentes :
 Quantity > Jvol

 Complex > CmplxMag

 Geometry > Surface > ProbeCurrent

 Normal

 ∫

> Cliquez sur le bouton Add

> Entrez le nom de l’expression 
(CourantLoad) et OK

> L’expression apparait dans la liste Named
Expressions

> Cliquez sur Done.
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Analyse courant tensionAnalyse courant tension

> Résultat

> Le résultat peut sembler adéquat, mais la formulation utilisée pose problème …
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Analyse courant tensionAnalyse courant tension

> La mesure de la tension n’existe pas nativement sur HFSS. En effet, la notion de 
tension n’a de sens que si elle est définie entre 2 points, positionnés sur 2 conducteurs, 
faiblement éloignés (distance << λ).

> La tension V en un point d’une ligne microruban peut être définie de la manière suivante 
:

Plan de réf.

Piste

Ligne C 
(quelconque)

Champ E
஼
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Analyse courant tensionAnalyse courant tension

> On ajoute une ligne en bout de piste, entre la piste et le plan de masse.

> On la nomme LineVoltageLoad

Line Voltage Load (contour 
d’intégration du champ E entre le 
plan de masse et la piste)
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Analyse courant tensionAnalyse courant tension

> Utilisation de la calculatrice de champ 
pour calculer la tension :
 Quantity > E

 Complex > CmplxMag

 Geometry > Line > LineVoltageLoad

 Tangent

 ∫

> Cliquez sur le bouton Add

> Entrez le nom de l’expression 
(VoltageLoad) et OK

> L’expression apparait dans la liste Named
Expressions

> Cliquez sur Done.
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Analyse courant tensionAnalyse courant tension

> Pour tracer l’évolution de la tension aux bornes de la charge en fonction de la 
fréquence, HFSS > Results > Create Field Report > Rectangular Plot
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Modification de l’excitationModification de l’excitation

> On change l’excitation pour mettre une source de courant

> File > Save as  Microstrip_Project5. On reste en solution de type Terminal.

> On sélectionne la face externe de la forme et HFSS > Excitation > Assign > 
Cuurent.

> Sélection de la ligne Current flow line.
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Modification de l’excitationModification de l’excitation
Simulation de la tension :

Simulation du courant :
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Simulation du champ procheSimulation du champ proche
> Deux éléments géométriques possibles sur lesquels réaliser le calcul : une 

sphère ou une ligne.

> Exemple : on dessine une ligne à 1 mm au-dessus de la piste, perpendiculaire à 
la direction de la ligne. On la nomme LineNearField.
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Simulation du champ procheSimulation du champ proche
> HFSS > Radiation > Insert Near Field Setup

> HFSS > Results > Create Near Field Reports > 
Rectangular plot
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Simulation du champ procheSimulation du champ proche
> Pour observer la distribution du champ sur une surface planaire, on dessine une 

surface (par ex. un rectangle dans le plan XY à 1 mm au-dessus de la piste).

> Draw Rectangle
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Simulation du champ procheSimulation du champ proche
> Sélectionner ce rectangle

> HFSS > Fields > Plot Fields > E > Mag_E

Tracé du module du champ E total sur une surface 
rectangulaire à 1 mm au-dessus de la piste.

> La catégorie Standard ne permet pas de tracer individuellement les composantes X, 
Y, Z du champ, ni les parties réelles, imaginaires ou la phase.
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Simulation du champ procheSimulation du champ proche
> Cliquez sur le bouton Field Calculator

> Par exemple, pour tracer la partie réelle du champ Ez :
 Quantity > E

 Smooth

 Scal? > ScalarZ

 Complex > Real

 Add  sauver l’expression : Ez_reel.

 Done
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Simulation du champ procheSimulation du champ proche
> Tracé de la partie réelle du champ Ez, à 1 mm au-dessus de la piste

Un problème apparait : distribution du champ E très granuleuse, peu uniforme !
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Critique du modèleCritique du modèle
> Conseil pour les dimensions de l’objet Air Box (Boundary de type Radiation) :

 Les limites de l’objet Air Box doivent être hors de la zone de champ proche de l’objet rayonnant simulé 
frontière floue

 Commencer par une séparation de λ/4

> Utilisation d’un ordre 1 pour els fonctions de base (pour l’interpolation du champ entre les 
mailles)  passage à 2 si besoin de plus de précision au prix d’un temps de calcul plus 
élevé

> Analyse du maillage : clic droit sur objet + Plot Mesh

Nombre totale de mailles = 12841
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Amélioration du modèleAmélioration du modèle
> L’augmentation de la taille de l’objet Airbox serait à 

analyser, mais ici pas d’influence car l’élément 
rayonnant (la piste) est à λ/4 des bords. Le nb de 
mailles augmenterait largement sans réelle 
amélioration

> Réduire la taille du maillage : 

 soit en limitant la taille des mailles (Assign
Mesh Operation)

 Soit en réduisant le paramètre Lambda Target
 plus efficace

> Augmenter l’ordre des fonctions de base : ordre 2 
ou mixte (temps de calcul plus long)
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Amélioration du modèleAmélioration du modèle
> 119864 mailles  sans doute un nombre de mailles un peu exagérés…

> Simulation du champ proche :


